


CineForm First Light Contents

Welcome to First Light

Workflow Overview
1 Set Up
2 Image View, Framing and Display Controls

3  Color Correction and Adjustment

4  Stereo (3D) Correction and Adjustment

5 Save Databases, Snapshots and LUTs

6 In Summary: The Most Versatile Workflow
Operations

1 Playback settings/Open GL
2 Enabling HDSDI
2 Workspace Curves
3 Burn-in Controls
3 Adding Metadata Display
3 Controls
4 Metadata Types
4  Displaying the Tools
5 Format Specific Settings
5 DeBayer Filtering
5 3D Display Types

Project
1  Start a work session
1 TIP: Plan your project structure
2 Importing Assets
2 Loading a clip in the Preview Window
3 Global Controls
3 Active Metadata Controls
4 White Balance
5 Primary Corrections
6 Using Look Up Tables, or LUTs
7 Framing
8 3D Corrcetions
9 Moving your adjustments between clips
10 Saving your work
11 Creating CineForm 3D Files

Panasonic AG-3DA1
1  One Step File Conversion
A Possible Approach: User-Created Directory Structure
Selecting Files for 3D Multiplexing
Designate a Destination Directory
Mux Settings
Conversion Settings
Processing the Queue
Queue Additional Directories

ADhNWWWNKE

Appendix
Framing
Starting a Post Production Project

cineForm

EH@ g:gggﬁ? USER DOCUMENTATION 8/1/10




() Primary Carrections B Enable

Sometimes a fear of commitment
makes something beautiful happen...

CineForm® First Light™ is the interface that allows you access to all the available parameters inside
CineForm's Active Metadata™ technology associated every CineForm media file.

CineForm has created a framework that goes beyond production quality image encoding and decod-
ing to include control of image development and color properties in your source media including
white balance, gain, gamma and lift, exposure, contrast and saturation, the color matrix, and the
implementation of 3D (such as film style) LUTs - all implemented in software in real time.

In addition to color correction, First Light also includes controls for adjusting the 3D relationship be-
tween the ‘eyes’ in a CineForm 3D stereo pair. First Light also provides the interface for muxing
(multiplexing) two single-stream files into a stereoscopic CineForm file.

Since this is all done using CineForm's Active Metadata, without permanently altering the media or
“baking in” these changes, the media remains stored in its original state and available for limitless
further adjustment or revision to be performed non-destructively. Active Metadata adjustments are
stored with the file, and applied at the point of decode, so any application that plays the media
“sees” the adjustments you've made as part of the file with no further steps necessary.

Active Metadata (as well as Passive Metadata) is kept in a database that is stored as a part of the
media file, but it remains separate from the essence (the original image data) allowing Apple® Final
Cut Pro®, QuickTime® Player, Adobe® Premiere® Pro and After Effects®, Sony Vegas™, Windows
Media® Player, or any other application that opens your media file to play it with the adjustments
you created. This allows anything from subtle to aggressive manipulation of color operations on
CineForm AVI or MQV files at any time while leaving your original source images unaltered.

The concept of making adjustments to CineForm metadata is likely familiar for Prospect 4K users
who have used the controls in Premiere Pro previously. First Light is the same principle with a
vastly improved user interface running over a far deeper feature set, plus the ability to create proj-
ects, manage databases, and save presets spanning multiple sessions.

...and since there is no actual change to your source media, you can change your approach again
and again without any source media degradation.

You don’t have to fear commitment if you don’t have to make any.

Welcome to First Light.
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1. Set up and save the First Light project file

Ctrl=N

New Project
Your First Light project may be accessed multiple times throughout a pro-

Cpen Project Ctrl=0
duction. It's a good practice to save the project (once there are files in the Save Project s
clip library) to the directory on your computer where the media and asset e Proiect RIS AHS
. . . ave Frojec ri= -
files are stored for the production project. This can be particularly important . PJ
ecent Projects »

if you are involved in multiple production projects.

2. Importing assets

New Project

There are several ways to designate media files for your
clip library. Open Project
“File> Import File...” or pressing the Control + I
(Command + I on a Mac) can be used to bring in media
files, or just right-clicking in the clip library window will
bring up the Import File Window.

Recent Projects
Import File... %Ctrl !

3. Make adjustments in First Light -
First Light has access to an extensive list of properties for adjusting or viewing both active and passive metadata

At this stage, it may be helpful to start with the initial interface and available Active Metadata controls. Three basic
functions are represented in the center and right side panels:

A. Image View/Mid-Panel

B. Color
Correction/Adjustment

C. 3D
Correction/Adjustment

=% = 00:00:04:13 |

Gl

(continued next page)
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Image View,
Framing and
Display Controls

-The playback control designates
which of your changes are visible
when the clip is playing back.

00:00:39:01
B

-On the right side interface toward the bottom of the Active
Metadata tab, there is the “"Framing” parameter which con-
trols zoom and 2D offset as well as frame shape crop options.

r—r—— TH T

cineForm

what metadata, text, and diagnostic displays are displayed on the

-In the Burn In Controls tab, there are parameters for controlling ]
video clip.

(continued next page)
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CineForm First Light Workflow Overview (3 of 6)

Color Correction and Adjustment

-Workspace Curves parameters in- Active Metadata RSl 2

clude parameters for an Encode and - 2D File
Decode curve as well as a Primaries =
Curve to tell First Light how a clip L
was encoded, how it should be de- ; e " () 3D Corrections ¥ Enable
coded, and how color manipulation

done in First Light should be applied.

) Workspace Curves

) White Balance ¥ Enable
£ Primary Corrections ¥ Enable
') Look (3D LUT) ¥ Enable
) Debayer Filter

1) Framing ¥ Enable

¢ Snapshot Manager

-The parameters on the right side of the ) S ' I I I E F D I m

interface that directly manipulate the

visual {(color correction) properties of
the clip are in the White Balance and
Primary Corrections panels.

-The Look (3D LUT) param-
eter loads a Look Up Table of
an existing color adjustment
or aesthetic. First Light uses
*.Look’ format LUTs based on
the Iridas file type and will

load a LUT up to 64x64x64

resolution. -The quality/speed of the ‘Demosaic’ process,
used to construct CineForm RAW images from
a camera that uses a Bayer Pattern sensor is
controlled in the Debayer Filter.
(continued next page)
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CineForm First Light Workflow Overview (4 of 6)

Stereo (3D) Correction and Adjustment

These parameters control the visual stereo relationship properties of CineForm 3D media
clips. (...some stereo adjustments are available only in Neo 3D.)

Active Metadata

3D Control  @® Both Eyes ® Left Eye @ Right Eye

-Choose whether to apply your altera-
tions to both eyes, or one eye alone in
the 3D Control selection at the top of
the Active Metadata tab.

3D Corrections ¥ Enable

W Auto Zoom

. Horizontal * s 4 * 0.0000
-The 3D Corrections panel houses

the controls for convergence and

Vertical

frame manipulation for correction or B

creative control of the stereo relation- LD

ship between the two eyes in your 3D P

cligs Depth Tilt

The panel at right is for Neo3D. The MaskL =@ 00000
panel in NeoHD/4K does not include Mask R — (),0000

Keystone, Depth Tilt, Mask or Key-
frame controls.

Left Eye

-3D Display Types on the left side of
the interface, above the clip library,
controls how the left and right eye are
muxed (or not) or placed for playout. If
you are using a supported hardware or
display card that will output CineForm
3D media to a 3D display, this is where
you will choose what frame arrange-
ment you will use to feed that display.
This view setting will also affect all
other playback views in your editing ap-
plication or media player.

(continued next page)
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CineForm First Light Workflow Overview (5 of 6)

Save a Project: Saving the First Light Project
(File>Save Project) preserves the current clip library
listing in a file.

CineForm Metadata Database: The param-
eters you set up are stored in a database.
Each clip can only have one database active at
a time. You can create an additional or alter-
native database by expanding the Database
panel (at the top-left of the interface) and
clicking "New” and typing the name for the da-
tabase in the text field. All the databases you
create will be available to First light in the
‘Current’ options and you can use the Export
function to save an external file to share data-
bases between workstations or members of

Save a Snapshot: You can save the current color
alterations you‘ve made for later recall by using the
Snapshot Manager in the lower right of the inter-
face. Saving a Snapshot will make it available for
application to one, or a series of clips you select in
the clip library. A Snapshot file is saved within First
Light.

Export a LUT: just as First light can import
and apply a Look Up Table, it can also Export
a LUT containing your current set of altera-
tions, as a .Look file. Any other application
that understands and imports a .Look file can
then apply your set of adjustments as a LUT.

Save Databases, Snapshots, and LUTs

[Fite | qit View
New Project
Cpen Project
Save Project
Save Project
Recent Projects

Import File...

~ Database

There are several ways to output or save your adjustments, corrections, and the aesthetic
looks you create in First Light.

Ctrl+N
Ctrl+0
Ctrl+S
Ctrl+Atl=S

L3

Ctrl<l

More

(continued next page)
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CineForm First Light Workflow Overview (6 of 6)

In Summary:
The Most Versatile Intermediate Workflow Available

You can operate CineForm First Light as a stand alone application and prepare clips for post production in
another application at a later time, or you can run First Light WHILE YOU EDIT. When you change the
focus to First Light to make a change in a clip, when you change the focus back to your editing application
and refresh the overlay (as simple as just advancing a frame), your changes will be immediately applied.

And the changes are implemented in CineForm’s Active Metadata Processor, as opposed to conventional
video workflows implementing changes as a separate process after the decode process is complete. The
speed and versatility will surprise you.

...or if you're a past CineForm customer,
you may not be surprised at all.

cineForm
Processor

Media Storage

cineForm

EH@ g:vggh USER DOCUMENTATION 8/1/10



CineForm First Light Operations

Playback settings

Decode resolution for playback

Automatic
Full Resoluticn

E v Half Resolution

s

Enable Output Card
Cutput Card Preferences..

CineForm media can be played back at full, half, or quar-
ter-resolution inside First Light by choosing an option
under the View pull down menu.

Adjusting the view quality does not affect the media file, OpenGL Player Preferences...
but adjusting to half resolution (or with 4K images, quarter
resolution) may allow for smoother playback on some sys-
tems. Choosing View>Automatic will adjust the video
resolution to fit your display.

Enter Primary Menitor Fullscreen Mode Alt-Enter

*The 'Use YUV’ setting would be for display cards that
have analog component output designed for use with
an outboard video monitor.

Open GL PIayer Options

3D Playback Disabled

Pa:slv: SD Herizantal Interlace
Passive 3D - Vertical Interlace
NVIDIA Page Flip 3D

Frm.au, Monitor Fullscreen =y !

HI I

[Enable Standard 2D Playback
OpenGL Not Used
Enable Standard 2D Playb

Enable Passive 3D - Fonmnl‘al Interlace
Enable Passive 3D - Vertical Interlace
Enable NVIDIA Page Flip 3D

Passive 3D - Hanzonta Interlace
Passive 3D - Vertical Interlace
MVIDIA Page Flip 3D

On a Windows system with an Open GL display card, First Light will utilize Open GL to augment playback
performance. View>Open GL Player Preferences will open the Open GL Options window.

The Internal Window refers to the video viewer inside of First Light’s interface. The check box enables
Open GL for 2D video playback and the drop down menu designhates specific methods of displaying stereo
video clips on ‘3D’ displays, allowing you to choose Passive Horizontal, Passive vertical or NVIDIA’s Page

Flip 3D system.

Primary Monitor Fullscreen controls the Open GL attributes for displaying First Light's overlay full screen
oh your primary desktop monitor, and another set of options for a Secondary Monitor on your system
that you may be using as a your fullscreen view of video from First Light. Each monitor has individual con-
trols for 3D display type, or an option to shut off Open GL support entirely.

For 3D stereo media, the ablitity to swap channels or ‘eyes’ is controlled for the primary and secondary
monitor individually with check boxes at the bottom of the window.

(continued next page)

cineForm

E”@ g:ggEﬁT USER DOCUMENTATION 8/1/10

(1 of 5)



CineForm First Light Operations (2 of 5)

Playback settings
Enabling HDSDI Output

With a compatible AJA or Blackmagic HDSDI card installed on your system, you
can output directly from First Light to your HD display and /or your external
HDSDI waveform and vestorscope. Choose View> Enable Output Card to ac- Output Resolutio _i
tivate the HDSDI option and use View> Output Card Preferences to choose B ot e

your Output Resolution manually, or to view clips in their native resolution, leave B ot

the setting as "Auto’. Note that 2K and higher resolution material will be scaled
to 1920x1080 for playback.

If you are viewing your 24 fps material on a 29.97, 1080 interlaced monitor via HDSDI, you can check the
‘Output 24p as 60i’ option to add pulldown for viewing. Check ‘Faster Scale for 2K and 4K source’ for
more fluid playback of large-raster material on systems having difficulty maintaining framerate during play-
back.

Playback of First Light changes in Premiere Pro and Final Cut Pro via an AJA Kona card is also supported so

you can operate an edit session and work with First Light and see all adjustments immediately via HDSDI
output.

Workspace Curves

The Encode Curve present in an image that does not have a linear grayscale
is often referred to in industry slang as simply “"gamma”.

This curve, and the nature of its power function are the basis for encoding
images for viewing on display systems that are not linear. Since First Light
displays your clips in order for you to make visual decisions, it needs to present the image ac-

curately. In order to do this, First Light needs to know the nature of the encoded curve used SiLog
when your footage was created to properly interpret it. You would set Input (Encode) Curve Cineon 953-685
to this value using the presets in the menu, or enter in a custom value in the ‘Power’ space. Linear Light

m Log
m Gamma

The Output (Decode) Curve is a separate function, designating how the image will be pre- mC
sented on your display as you work. The normal practice would be to use the same curve spec- '
ified as the input curve.

Identifying the encoder curve provides the metadata to the CineForm decoder engine so that it can apply the in-
verse curve to restore to linear light.

Ideally, the *Primaries’ curve would then be set for ‘Linear Light’ under most circumstances. You can also
choose the current output curve. While this is a matter of each user’s choice, applying color adjustment in linear
light is considered a best practice in the industry and will make your results far more predictable as you move
through the rest of your post production process.

(continued next page)
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CineForm First Light Operations

(3 of 5)

Burn-in Controls

Adding Metadata Display
Clicking on the *‘Burn-in Controls’ tab will bring it to the front.

Inside the panel are the controls for creating information and
graphic overlays for your clips. Displaying metadata on the clip
image during playback could serve a wide variety of purposes
from displaying clip timecode on the image in your editing envi-
ronment to later create a timecode “burn” copy for approval, or
you may place a slightly opaque company logo over footage
you want to keep secure as a watermark.

You may also want to display diagnostic displays such as wave-
form, vectorscope, or histogram information while you make
color adjustments.

Controls

The ‘Burn-in Controls’ panel may be collapsed when you first
open it. Click the ‘More’ button along the left side to expand it
and make all controls visible.

The ‘Layout’ property on top controls whether your changes
will be assigned to all clips, or just the one that is currently se-
lected and in the mid-panel.

“Justification’ controls allow you to place a given overlay item
in the screen, corner, or center justified. The ‘Add/Remove’
button acts on the chosen item with its function changing
based on whether the item is currently displayed or not. A
series of items can be shifted in order on the screen using the
‘Reoarder’ function.

Burn-in Controls

# Bumnin Controls

Layout: ® All Clips (Global) @ Current Clip (Local)

5 | = Burnin: m

Justification: [EIIED
=) Reorder:
More Font: [Arial | Size:
fil: [ ©sete:[ ] stoke:[ | wiam:[0 ]
Opacity: —_—G0
Custom Format (str %s, num %ed):
Parallax (3D):
Timing: 0

Overlay Region:

Bxport Layout

7 Add Overlays

MNote: note

Graphics:

= Metadata

Text or numeric metadata displays are defined by the font, size, color and opacity controls. Each item can be as-
signed a different set of values (perhaps out of several lines of text, one needs to be larger...or more opaque).

The *Custom Format’ text field allows you to add a custom text string to a metadata value.

The *Parallax 3D’ control is for placement of text into a 3D clip, determining its apparent “depth.”

The ‘Timing’ controls can bring an item on and off screen at specified points using a set in-point and a frame dura-
tion, and the item can fade on and off for a set duration. Use the R’ button to reset these properties.

Define the “borders” of your placement area on screen by defining the ‘Overlay Region’. In the next panel down,
you can type a custom piece of text and place it on screen, and you can specify a graphic file (.PNG format) such as

a logo or copyright watermark, etc. for placement as well.

Save your configuration for later recall using the ‘Export and Import Layout’ buttons, and use the ‘Reset

Layout’ button to clear a layout’s parameters and start over.

(continued next page)
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CineForm First Light Operations

(4 of 5)

Burn-in Controls

Metadata Types

The *‘Metadata’ panel displays the types of metadata that are -
available inside a given file. Depending on a clip’s origin, the = Metadata
amount and type of information vary widely.

While software registration data like your “hardware finger-
print” or registered user name is probably not important for
video purposes, the timecode value under the ‘CineForm’ list-
ing is probably one of the most frequently displayed values in
the metadata selection.

The additional listing under CineForm that will be a constant
no matter what the source material, is the ‘Tools’ listing.

Displaying the Tools

The ‘Tools’ listing holds the display items that you would use for
accurate technical assessment of the visual properties of your
image as you make adjustments.

Use the screen placement, sizing, and opacity tools to place your
technical displays over your video. As with all metadata ‘Burn-in’
items, if they are applied globally, you will want to be sure to
shut them off before doing any video export or mastering from
your NLE system, as they will "bake in” at the point any video is
re-encoded.

In addition to the color and luma in-
formation supplied by the traditional
diagnostic displays, you can also Histogram
deploy vertical and horizontal grids
to be used as alignment aids, par-
ticularly when working with 3D mate-
rial and altering the relationships be-
tween the left and right eyes.

Waveform RGB

(continued next page)
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CineForm First Light Operations (5 of 5)

Format Specific Settings

CineForm RAW: DeBayer Filtering

Many RAW files are acquired on Bayer pattern image sensors, Default

and the term that has come to describe the process of inter- Bilinear Demosaic
preting that data is “DeBayering” There are a variety of Matrix 5x5 Adaptive
ways to implement this process, some being faster and less B

taxing on a computer system, others requiring more computer CF Advanced Smooth
resources with the benefit being a higher quality, more finely

CF Advanced Detail 1

detailed image. CF Advanced Detail 2

CF Advanced Detail 3
BiLinear Demosaic is a good choice for editorial since it's a CF Simple Smooth
simple, fast demosaic filter suitable for real-time playback, CF Simple Detail 1
but many would find it less acceptable for final rendered CF Simple Detail 2
output.

When the DeBayer Filter setting is in Default mode, the BiLinear Demosaic is always used for timeline
playback during editorial. During high-precision render the CF Advanced Detail 1 demosaic is used.

As you move through Demosaic algorithms from BiLinear to CF Advanced Detail 3, each level adds addi-
tional sharpening and detail, trading speed and computer resources proportionately.

You may want to evaluate different demosaic modes during render to see what level of sharpening is best
suited to your needs in any given situation..

CineForm 3D: 3D Display Type

The CineForm Active Metadata processor formats playback on your Cine- Left Eye
Form 3D (Stereo) media to the 3D presentation format appropriate to give Right Eye
you the feedback you need for the the adjustments you’re making, or to Anaglyph: Red/Cyan
properly supply stereo video to your 3D display device. Anaglyph: Amber/Blue
Anaglyph: Green/Magneta
2D single channel view: Left Eye or Right Eye Line Interleaved
Onion Skin
For Anaglyph Display: Red/Cyan, Amber/Blue, or Green/Magenta Difference k

Over-Under

Side-by-Side
Free View
Split View

For Polarized Display: Line-Interleave, Over-Under, Side-by-Side

Convergence Adjustment Assist: Onion Skin or Difference

You can change the 3D Display Type at any time during a First light session, or during editorial on your
NLE. Keeping First Light running in the background during your edit session will make the 3D Display Type
available to change as necessary as the setting affects all applications using CineForm 3D files.

cineForm
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CineForm First Light Project

(1 of 11)

Start a work session

When you open First Light, you will start with an empty
interface. The project will need to be given a name and
saved.

You can load an existing project from File>Open Project,
or by typing Ctrl+0. You can start working in a new
project by simply importing some clips by using
File>Import or Ctrl+I, or...simply click in the clip library
panel to summon an import dialog.

A First Light project is a stored list of clips. The meta-
data adjustments you make will be saved in other forms
during your project.

You may elect to save all your First Light projects in a
central location, or to save them with each project, or
even by scene if you are working on a long narrative
project.

(&5 CineForm Firstl

. File | Edit View 3D
New Project Ctrl+N
Cpen Project Ctrl-0
Save Project Ctrl+S
Save Project Ctrl-Atl+5
Recent Projects
Import File... Ctrl=I

Exit

Clip Library (5 items)

5029 Leaves-Drop Focus-001.avi
Table top.avi

window.avi

SMC-2116_01.avi

count for it.

TIP: Plan your project structure

Ideally, you would start setting up your First Light workflow with the project and a system in mind.

As a starting point, you may want to review the special section on “Project Planning Consider-
ations” list in the appendix before you begin to work.

For many projects, going through this list of considerations may not be necessary. If you are shoot-
ing the project and editing it yourself, maybe having a rigid system isn't as critical to the project’s
success as it would be in an environment with many contributors. However, starting a project with
some consideration for detail and and process can save time later. Getting well into a large project
and realizing the naming schema needs to be revamped, the databases need to be subdivided differ-
ently, or the workflow needs some accommodation, takes you away from production while you ac-

First Light was created to make you more productive, and having a strategy to deploy LUTs, data-
bases, and project clip lists will help you take full advantage of the CineForm workflow.

(continued next page)
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CineForm First Light Project (2 of 11)

Importing assets

First Light can import assets in a variety of ways depending on
your preferred way of working.

File | Edit View 3

New Project
“File> Import File...” from the application menu. Open Project
Press the Control + I (Command + I on a Mac) to open the
Import File Window

Recent Projects
Right-clicking in the clip library window will bring up the Import Import File...

File Window. .
Exit

...or you can simply drag media from your computer’s file faGELEECRene]

system directly into the First Light clip library.

Load a clip in the Preview Window

When the clip is in the preview panel, it has the focus of all of the tools in First Light.

You will see a play/pause button below the Preview Panel as well as single frame forward/reverse buttons
on either side. You can play your clip and/or examine various frames while you make adjustments. You

also have the option to check the “loop” box to enable playback looping if you prefer to make adjust-
ments while the clip is playing.

(continued next page)
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CineForm First Light Project (3 of 11)

Enabling and Disabling Adjustments

Global Controls

2D File

In the mid-panel, you’ll notice checkboxes for the various adjustment
categories inside First Light. These ‘Global Controls’ affect what Cine-
Form Active Metadata is read for all CineForm media being called by all
applications on that local machine. Red 1.000

Green 1.000
You may want to perform color correction with any LUTs you’ll be using Blue 1.000
to be ‘on’ but you may find for editorial that the LUTs are less impor-
tant than the fastest possible response...in this case, you would have Tint ; ils
First Light running in the background while you're editing, allowing yo S —”—[_—_
to simply click into First Light and shut off LUTs for all CineForm medi : —
on that machine. When editorial is finished, you could simply turn on Primary Corrections ¥ Enable
the LUTs for the final check and exporting. Base Matrix [Neutral

White Balance ¥ Enable

Temp. 5600

1

Exposure 1244
These adjustments are different than the enable/disable capability :

inside the adjustment panels themselves.

Contrast 1.000

Saturation 1122

Gain 0.980
Red 1.061
Green 0.909

Blue 0.969
M 3D Corrections M Tools

O O . O O . 17 '47 ¥ White Balance M Overlay Gamma 1.079

¥ Primaries Red 1.059

Sync Frame: 0 H H ¥ Looks (3DLUTs) Green 1.119

® 2D/Left Eye ® Right Eye W Framing Blue 1059
M Image Flips

0.000

I I OO OO
ICHED (RN (NN B

0.000

Resolution: 1280x720 Frame Rate: 59.94018

Active Metadata™ Controls

Along the right side of the First Light interface, you’ll find the controls for “White Balance’, ‘Primary (color) Correc-
tions’, managing ‘LUTs’ (Look Up Tables), and *Snapshots’, as well as the tools for doing ‘3D Corrections’ on Cine-
Form Stereo clips.

These parameters all affect the visual attributes of a clip, therefore they are considered to be ‘Active Metadata’. Other

metadata such as the timecode or visual diagnostic displays available in the *‘Burn-in Controls’ can be exposed and
displayed, but not changed. CineForm refers to these attributes as Passive Metadata.

(continued next page)
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CineForm First Light Project (4 of 11)

Making Adjustments to your footage

White Balance

() White Balance ¥ Enable
Red a 000 BE

Green @ 1.000 E a

Blue @——————— 1000 BE

Temp, 1 =@ 5600 [HH
Tint —— o mm

W Enable Keyframes DED

Often the initial step for someone handling the color work on any footage, *‘White Balance’ really refers to a general
color balance. Most video cameras will be set for a white balance in the field to remove any color casts from highlights
by changing the camera’s perception of white to be the Kelvin measurement of the light source (often referred to as
“color temperature”- usually done along with a ‘black balance’ to reference the camera to a neutral black with the iris
closed).

However, in cases where the footage still needs adjustment, or in the case of RAW video, ‘White Balance’ controls
are still a good place to start color correction operations. If there is a neutral white object in your image, you can click
on the *Pick’ button and click on your image to automatically balance the entire image. The slider controls in the inter-
face add color along the primary color axes and ‘Temp.” and ‘Tint’ correlate to the ‘I’ and ‘Q’ axes on the vectorscope
face as shown. White Balance can be keyframed to change over time if necessary by enabling keyframes and adjust-
ing the values, adding a keyframe at each point necessary. Use the ‘Reset’ button to return to default settings.

With all adjustments of Active Metadata, verify that both the adjustment is enabled in the panel, and that the adjust-
ment is also enabled in the mid-panel so your changes are visible.

(continued next page)
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CineForm First Light Project (5 of 11)

Making Adjustments to your footage

Primary Corrections

Primary Corrections I Enable

Base Matrix |Neutral | m

Exposure 1.244

Contrast 1.000

Saturation 1458

Gain 0.980
Red 1.061
Green 0.909

Blue 0.969

Gamma 1.079
Red 1.059
Green 1119
Blue 1.059

Lift —— 0003
Red —@———— 0010
Green =l 0000
Blue =@ 0000

W Enable Keyframes DED

AE
i
il

Primary color correction typically refers to image adjustments that affect the intensities of the three primary color
channels. First Light's *Primary Corrections’ panel has adjustments for Gain (highlights), Gamma (midtones) and
Lift (Shadows), with an adjustment for each primary color, as well as an overall adjustment for each of the three.

You also have an overall control for Exposure, Contrast and (color) Saturation. At the top, you’ll notice the *‘Base
Matrix’ designation which you would typically leave set at Neutral, unless your camera has a set matrix (you would
set this to “"Camera”), or if you’ve created a custom matrix in an earlier version of Prospect 4K (set to "Custom” to
preserve it).

Primary Corrections can be keyframed to change over time if hecessary by enabling keyframes and adjusting the
values, adding a keyframe at each point necessary. Use the ‘Reset’ button to return to return the panel to default.

With all adjustments of Active Metadata, verify that both the adjustment is enabled in the panel, and that the adjust-
ment is also enabled in the mid-panel so your changes are visible.

(continued next page)
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CineForm First Light Project (6 of 11)

Making Adjustments to your footage

Using Look Up Tables (LUTs)

{< - |

¥ Enable

CF_CandyColorCooler
* CF_CoffeeFilter

CF_CoolBleach
CF_CoclContrast
CF_CoolTones
CF_DayForNight
CF_DayfForNight2

nStyle_5245
CF_FilmStyle_5246
CF_FilmStyle_5247

CF_FilmStyle_5620

A d CF_FilmStyle_Alt
00:00:18:01 | & e & B
o o - - -
- /|
|

B ¥ Looks (3DLUTs)

In the ‘Look (3D LUT)’ panel you have the ability to load and export set groups of color adjustments that create a
specific aesthetic. Valid Look files match the Iridas .Look format and support up to 64x64x64 resolution. Look files
can be created on any PC or Mac using Iridas Speedgrade OnSet and copied to your system with First Light installed.
Double-clicking on a .Look file within Windows Explorer will register it for use on the system.

Clicking on the ‘Preset’ option field will display a list of the Looks that are installed on your system. First Light ships
with 35 Look files for your experimentation. You can save specific sets of adjustments as .Look files as well by using
the ‘Export’ button. Once you exported the .Look, you can make it available to your system by accessing it from your
OS and double-clicking on it.

Use the ‘Restore’ button to return your clip to it’s original LUT (if it had one), or you can ‘Reset’ the LUT panel com-
pletely and start from a clean image.

With all adjustments of Active Metadata, verify that both the adjustment is enabled in the panel, and that the adjust-
ment is also enabled in the mid-panel so your changes are visible.
(continued next page)
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CineForm First Light Project (7 of 11)

Making Adjustments to your footage

Framing

AR
AR
L]

M Enable Keyframes DD

®none ®43 32 & 169 @ 1851 ® 2391

Frame Flip M Horizontal M Vertical

¥ Framing

In the *Framing’ panel you'll find the controls for what many of us refer to as “pan and scan”. You can take your ma-

terial and zoom into the frame to change your composition, and you can use the *X-Y Offsets’ to reposition the
frame.

You can also mask your composition using the various options along the bottom, ranging from a 4:3 mask, which
would “pillar box” a 16:9 frame, to 2.39:1 to simulate the look of cinemascope. You can use the X-Y Offsets to reposi-
tion your shot within the mask, making the entire process transparent to your NLE or media player application.

You can also flip your image either horizontally or vertically utilizing the checkboxes. (Note that “Image Flips”is a
separate enable checkbox in the mid panel from ‘Framing’.)

Framing can be keyframed to change over time if necessary by enabling keyframes and adjusting the values, adding a
keyframe at each point necessary. Use the *Reset’ button to return to original framing.

With all adjustments of Active Metadata, verify that both the adjustment is enabled in the panel, and that the ‘Fram-
ing” AND/OR the *Image Flips’ adjustment(s) is also enabled in the mid-panel so your changes are visible.

(continued next page)
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CineForm First Light Project (8 of 11)

Making Adjustments to your footage

3D Corrections (keystone, Depth Tilt, Mask and Keyframing controls available exclusively in Neo3D.)

3D Control @ Both Eyes ® Left Eye ® Right Eye

f___.' 3D Corrections Enable
Watozoon T N
Horizontal =d—————— (0000
Vertical =——————@——— 0.0000
D.Zoom =—————@——— 10000
Skew —G— 0.0000

Keystone ————@————— 0.0000
Depth Tilt =——@————-— 0,0000
Maskl =—————@——— 00000
MaskR ——————@——— 00000

W Enable Keyframes DED

¥ 3D Corrections

At the very top of the Active Metadata column, you will see the ‘3D Control’ options for working on both eyes, or one
individual eye. There are times when one channel needs a slight adjustment due to camera misalighment, or some
color work may be necessary on one eye when using a beam splitter camera rig. When you select one eye, your 3D
Correction interface will change and add control to specifically flip the selected eye and adjust Horizontal/Vertical
placement as well as zoom and skew. When ‘Auto Zoom’ is checked, you will notice that many of you adjustments will
affect both eyes in an attempt to maintain “framing”, however, complimentary adjustments are not made on the other
eye unless you reset 3D Control for Both Eyes.

The Horizontal, Vertical, D. Zoom, and Skew controls work with the two eyes as alignment adjustments for your de-
sired convergence. When adjusting Both Eyes, checking the *‘Auto Zoom’ box will create a zoom to eliminate any out-
of-bounds framing errors caused by alignment adjustments. Use Keystone to work with footage where the camera
angles were not properly alighed, and use Depth Tilt to change the relative depth of major objects in your scene,
though the adjustment itself will distort your image if pushed, so use it with care. You can also mask each eye sepa-
rately with the mask controls. (see: Operations, page 5 for more on 3D Display types and their function)

If you have Neo 3D, your 3D Corrections can be keyframed to change over time if nhecessary by enabling keyframes
and adjusting the values, adding a keyframe at each point necessary. ‘Reset’ restores the clip’s original state.

With all adjustments of Active Metadata, verify that both the adjustment is enabled in the panel, and that the ‘3D
Corrections’ adjustment is also enabled in the mid-panel so your changes are visible.

(continued next page)
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CineForm First Light Project

(9 of 11)

Moving your adjustments to other clips

Copy/Paste and Copy/Paste Custom

While most of us proabably have a grasp of copy/paste on our

computer systems, First Light expands this capability to become a

Very precision process.

You can, of course move one clip’s settings to another clip in your
project by having the source clip selected and using your copy
command (Ctrl+C on Windows, Cmd+C on Mac), then you can
select the target clip and paste with the appropriate 'V’ key combi-

nation.

B Paste Filter

/] 3D/Eye View
¥ Both
¥l Left Eye Delta
¥ Right Eye Delta

Copy Custom
Ctrl/Cmd+Shift+C

Paste Custom
Ctrl/Cmd+Shift+V

¥ Orientation
¥ Flips

¥ Zoom

¥l Primaries

¥ Exposure
Contrast
¥ Saturation
Lift

¥ Gamma
¥ Gain

Edit

¥ Workspace Curves

¥ White Balance

View 3D
Undo
Copy
Paste
Copy Custom

Paste Custem

Ctrl-Z

Ctrl-C
Ctrl=V
Ctrl=Shift+C
Ctrl=Shift+V

® Look (3D LUT)

¥ Debayer Filter

¥ Framing

¥ Local Overlays

When using the ‘Custom’ commands for Copy OR Paste, you get a dialog that allows you to select what
attributes of the source clip’s adjustments you want to copy, or to paste. You may want to copy all of

the attributes of a certain clip, but then paste to two other clips with two different subsets of those set-
tings. By selecting Paste-Custom, you have the choice of what will be moved to the target clip.

cineForm
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CineForm First Light Project (10 of 11)

Saving your work.

Projects Projects in First Light store a list of assets. If you have a short production with a small
number of clips, one project might be fine. On larger projects like a feature-length nar-
rative, there may be enough scenes, locations, and story aesthetic changes that subdi-
viding the material in some logical way makes it more manageable. Often since one
scene will need similar color adjustments, keeping your material grouped by scene can
make the job of tracking color on adjacent shots much easier.

Use File> Save Project or Ctrl+S (Cmd+S on Mac)

Databases Databases are the assembled ‘adjustments’ that you've ~ Database
made while in First Light. A database has an adjustment Current
logged for each clip that was in the project it was saved ) [
from. Each clip can only have one set of adjustments per
database, but you can save multiple databases. For
instance, you may have two approaches to the color
correction on a given scene...you could save a database *Save a ‘Sidecar file to
for each. For cases where you would like to create a new Zteosriflg'tflec‘él,?; ffjsflfgnf:ts

database that builds on the one you have currently, another First Light user

click on *‘Branch’.

Snapshots Snapshots are a way to save color treatments outside of databases. When you use
the Snapshot manager to save the adjustments you have made on the current clip,
you can call that set of adjustments back in any project using any database, and the
‘Load to Multiple’ feature will load that snapshot up for the entire clip library in your
project...a big time saver for handling large numbers of clips with relatively similar
requirements. Unlike a LUT, which locks in all the color settings as one function, a
shapshot loads with all the slider values set and can be altered.

Look Up Tables (LUTs)

Look up tables, or LUTs have been the standard method of transporting color in-
formation between different production devices for some time. From the ‘Look
(3D LUT) panel, you can import .look files from outside sources and withe the
“export’ feature you can save your own. LUTs saved by First light can travel to
other systems that will be involved in the project down the line from you to
ensure that the right information is maintained.

(continued next page)
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CineForm First Light Project (11 of 11)

Creating CineForm 3D Files.

CineForm 3D files are a combination of two source files. This process creates a new file, leaving your origi-
nal media intact. The first step is to load your converted CineForm files (labeling which is left and which is
right eye) into your First Light Project. Once the files are in the clip library, you'll need to declare within
First Light which is the left eye and which is the right by clicking on each, and while the clip is in the mid
panel, designating left and right using the buttons below the viewer.

7 Clip Library (2 items)

LE_Track_5_1080p24.avi

RE_Track_5_1080p24.avi

=% ® 00:00:05:10

Righttnd Left eye
clips in clip library

Sync Frame: 55 g g

® 2D/Left Eye ® Right Eye
When the two clips have been
identified as left and right eye, Left and Right eye designation,
you’ll next need to identify a and Sync Frame setting

‘Sync Frame’.

The Sync Frame is a frame you can identify in each clip as being a P
match. Many 3D shoots result in cameras that don't roll at '
exactly the same time, or there is an unintentional timecode offset. 3D Mux... Ctrl+M

In these cases, you heed to examine the clips visually and find the u-
frame you want to use as a sync point on each clip and click “Set”

next to the Sync Frame text field which will then display the frame number (not the timecode) you‘ve set. When
this is done for both clips, select them both in the clip library (Ctl+Click) and select “*3D Mux” from the 3D menu.

This will open the 3D Muxer window with your clips and designhated sync frames already in place. After you choose
a destination directory, clicking “Add to Queue will stage the job in the Queue.

Click on “Start Queue” to begin processing.
Each completed job in the Queue will indicate its status.
Lef Eye Fil ) As you send each job to the Queue, you can return to
Sync Frome: 55 First Light to stage additional clips and repeat the pro-
cess. When your clips are converted, simply import
them into your clip library and go to work.

Destination:

[ suopires Jl cengs [N N ot ]

File Name Sync Frame

*Add to Queue’ moves the job to the
Queue. Click on 'Start Queue’ at the
bottom of the window.

Clear Lompleted Clear Al

cineForm
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CineForm First Light Panasonic AG-3DA1 (1 of 4)

Panasonic AG-3DA1 Stereo HD Camcorder
One-Step Stereo File Conversion

The AG-3DA1 records video streams for right eye and left eye
views to two SDHC cards. Each pair of recorded SDHC cards
has both views, with each eye recorded to its own card.

Preparing your Panasonic Stereo AVCHD files for a
CineForm Post Production workflow is a simple
process, completed from within First Light.

Transfer your video files to your hard drive.

Using an SDHC card reader, transfer the entire contents of each
card to your harddrive. A good system for handling this data
will consist of a method for you to track the data by reel pair
and eye. Keep in mind that the naming conventions used by . _ .
the file system when the files are being written will not contain *You m'gt‘; want t% conS|derdIabeI||ngfyour
this information in a word-form, so you will want to take some SD.H.C media pairs by eye and ree # iy

i ) . efficient media management on location.
care to keep your stereo video clips well organized.

e . A
4 5 Local Disk (S:)
A Possible Approach: 4 || AG-3DA1_Media
User-Created Directory Structure 4 | Location Project Shoot
4
The directory you transfer to your computer from each ) Reel-l
SDHC card must maintain its structure and naming to > L Left Eye
function properly. However, that file directory can be )
transferred into a new directory intact. > nght E}"E
4
Creating a directory structure on your harddrive that ) Reel_2
gives you an immediate destination for the transfer of D 48 Left Eye
your video data, and keeps your SDHC card data :
paired properly by reel (or whatever designation you D 8 nght_Eye
want to give to each media pair), and clearly identified P Ree| 3
by right/left eye, will streamline your post production. o heel_
> L. LeftEye
> .. Right Eye
\. J

(continued next page)
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CineForm First Light

Panasonic AG-3DA1

(2 of 4)

Launch CineForm First Light

When you launch First Light, you can start withn an empty project, or

open an existing First Light project. In the ‘3D’ pull down me
on ‘3D Mux’ (or simply type Ctri+M).

Define file paths for left and right eye media.

When the 3D Muxer dialog opens, you will see that there are
two file paths to identify, one each for the left eye directory,
and one for the right.

Browse to your transferred video files.

To select the left eye file, click on *‘Browse’ and navigate to
the directory where you saved the left eye files you wish to
mux.

Inside the file structure of the transferred AVCHD media,
navigate down to the ‘Stream’ directory as shown in the file
hierarchy illustrated here.

Pick the first alphabetical file in the
‘Stream’ directory.

When you open the ‘Stream’ directory, you only need
to click on the first file in the directory (when orga-
nized alphanumerically). First Light will look at all
succeeding files in the directory automatically.

If you do not see files displayed in the ‘Stream’ direc-

tory, verify that the “Files of type:” text field indi-
cates Panasonic AVCHD (*.mts).

...continue by clicking ‘Browse’

nu, click

File

CineForm FirstLight - Location Shoot

Edit

View

Ctrl+M

Look in: | U8 Computer j
) ¢ Local Disk [52) ~
et | AG-3DA1_Media
Recent Places | Location Project Shoot
' . Reel 2
- .. Left_Eye
| PRIVATE
Desktop |, AVCHD
— | BDMV
-_-l'-l’.JJ %
Libraries =
. L

B select Left B8

Lookin: | ), STREAM

I
b2
Recent Places

Desktop
w=al/
Libraries

P
Name

=l

Date

¢ B e BB

Type

6/7/2010 11:04 ...

AVCHD Vi...

20000
001

6/7/2010 11:05 ...

Itern type: AVCHD Video

Size: 78.2 MB

Length: 00:00:29

) 20006

11:06 ...
11:09 ...
11:09 ...
6/7/2010 4:17 P...

AVCHD Wi...
AVCHD Wi...
AYCHD Wi...
AVCHD Wi...
AVCHD Wi...

File name:  |20000

L” Open |

Files of type: | Panasonic AVCHD (“mts) | ﬂl
7

to designate the corresponding first file in the appropriate Right Eye File directory.

(continued next
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CineForm First Light Panasonic AG-3DA1

(3 of 4)

Designate a ‘Destination’ directory and file name

After choosing the left and right eye source files, you can ‘Browse’ to select a destination directory for the con-
verted CineForm stereo files. You will need to designate a filename for the first target file, each subsequent file will
use that name, appended by a number.

MuxSettings

Click on the *Settings’ button to bring up the MuxSet-
tings dialog.

In the top section you'll notice the options to choose the
appropriate file wrapper, .AVI or MOV. as appropriate for
your editing system. You also have the option to define a

destination directory or change it.

Conversion Settings

The *Conversion Settings’ section gives you control
over the transcode process, which will convert your
left and right eye SDHC files to muxed stereo Cine-
Form files. (If you are muxing two CineForm files
without transcoding, these settings would not apply.)

When you set your ‘Quality’ level, keep in mind that
even CineForm Medium has excellent image quality
for many HD workflows. Each quality level up adds
image quality for higher end applications, but at the
cost of additional filesize and computing power.

You have the option to deinterlace or remove the
pulldown from non-progressive sources, as well as
rotate individual eyes during the conversion as would
be appropriate for your camera rig configuration.

3D Muxing Settings
Default destination file format:
fault destination directory:

Use last path ® Use left eye path

Conversion Settings (non-CincForm sources only)

W Remove Pulldown W Scale Cutput [l Override Frame Rate

1920x1080 (16:9) - 23976 -

Custom Rate:

M Deinterlace

| 1920x1080 (16:5)
Lows ) 1280x720 {16:9) k
Medium 14401080 (15:3)

gh
Filmscan 1

7200480 Widescreen (16:3)
Filmscan 2

T20wAE0 Letterbox (4:3)
7200480 Pan/Scan (4:3)
7204576 Widescreen (16:9)
720576 Letterbox (4:3)

7204576 Pan/Scan (4:3)

After you’ve chosen the parameters for your target file, including which eye’s shot will contribute the

audio to the clip, click on ‘OK".

(continued next page)
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CineForm First Light Panasonic AG-3DA1 (4 of 4)

Processing the Queue

Select ‘Auto Mux’ Ll ZS\ocnca Pye
Sync Frame:

After verifying the source and destination directo-

ries are correct, clicking *Auto Mux’ will auto-

matically transfer each clip pair in the source di-

rectories to the queue as individual events. Destination:  S:\AG-3DA1_Media\L

Right Eye File: S JA1Media\\Le roject Shoot\Reel_2\Right_Eye\PR 0
Sync Frame:

("Add to Queue’ will queue the clip pair identi- [ settings.__| Addito Queue

fied in the left and right eye text fields, but will
not queue the entire directory contents.)

Sync Frame

Queue additional directories

You'll notice that when you select *Auto Mux’,
the source and destination fields clear in the top
of the dialog. After one set of clips is moved to
the queue, you can designate another set of
source media and corresponding destination
target name and directory, setting a large
number of media conversions to complete in one
session.

If you should need to exchange the right and left
eye before the muxing operation, you can use the

‘Swap Eyes’ button to exchange the left and m

right eye source files.

Click on ‘Start Queue’

When all the clips you wish to convert are ready, clicking on ‘Start Queue’ begins the conversion process. Each clip
will show a *Waiting’ status until they begin the conversion process. While converting, there will be a percentage of
completion displayed in status, and finished clips will show *‘Status: Complete’.

Use the ‘Clear Completed’ button to clear the queue of clips that are finished converting, and the ‘Clear All
button to clear all designated conversion events and start with an empty queue.

...when your media is converted, it's ready to be loaded into First Light, and on through
your editing and post production software applications.
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CineForm First Light Fra‘ming Adjustments

Framing Adjustments using the crop function

16:9 Original

4:3 Crop

3:2 Crop

1.85:1 Crop

2.39:1 Crop
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1

CineForm First Light Project Planning Considerations

Planning a Post Production Project

Using CineForm’s First Light to your best advantage for any given project will be made easier if you start the proj-
ect by considering the overall workflow. The following is a list of possible factors you may want to consider.

1. Is there color metadata coming in with the footage, or will there be any information supplied?
a. A director and/or a DP may want to generate some aesthetic information to communicate to
post personnel what they originally had in mind when shooting.
- If they are planning to do this after field acquisition is complete, will they need access to clips?
Proxies? Still frame grabs for use in Iridas Onset to create .Look files?
- Will they use First Light at some other location and send you data? Will they send LUTs or databases?
b. Many cameras or digital video recording equipment can store color aesthetic information in the field.
- Will the footage be coming in with LUTs applied?
- Will they come separately?
- What filetype and resolution?
c. If there will be LUTs for each scene given to you, try to get a clear understanding of the
naming convention...or suggest one.
- Try to keep naming conventions based on script structure to streamline communication through post
- Decide whether it makes more sense to keep this information in the form of LUTs,
or through CineForm Metadata Database(s)

2. What kind of project is it?

a. A long-form project (particularly a feature-length project with a storytelling aesthetic in this context)
may have many scenes in different locations at different times of day, etc.

b. Will you want to subdivide your primary adjustments in First Light by scene? By location?
The presence of a key character?

¢. How will you construct First Light projects and clip libraries?

d. How might you be able to stay organized and also increase efficiency by designating particular
CineForm Metadata Databases for particular parts of the project?

3. How much media is involved? How do you handle it practically?

a. If it's a big project, moving media around between many locations, or even office to office
may be impractical.

b. How could the workflow be subdivided so that the process is as streamlined as possible?

Can color info be generated by a colorist or other post crew and sent to the editor’s work station

while the editor continues to cut?

c. Will you grade a representative shot from each scene initially...possibly for a draft edit...
then go in and make finer adjustments?

4. What software/hardware will be involved in the process when you account for every step?
How are you handling any incoming color decision information?
Are you leaving a CineForm workflow at some point? (perhaps to finish on a different system?)
How is color information best carried forward? “Baked” in? LUT?
If you are sending color decision info forward as LUTs, will they applied per scene? Per shot?
Perhaps you’'ll correct with a LUT turned on in First Light, then turn it off and save it separately

for application at a later stage on other equipment?

® o0 TV
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